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Please visit our

Computer Tutor
to learn more about computers!
One-on-one computer assistance is provided on a
first-come, first-served basis.

Available most Thursdays
Please see the computer lab schedule
for details.

Take-Along Tutor:
Basic Computers with Windows 2007
Use this handy guide to familiarize yourself with a personal
computer. And remember, you can always contact the
Reference Desk if you have a question about using the library’s
computers.

Some Computer Terminology
Monitor
Another term for display screen. The term monitor, however, usually refers
to the entire box, whereas display screen can mean just the screen.
Keyboard
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The set of typewriter-like keys that enables you to enter data into a
computer. Computer keyboards are similar to electric-typewriter
keyboards but contain additional keys.

Special Keys on PC Keyboards
 Arrow Keys -- Most keyboards have four arrow keys that enable
you to move the cursor (or insertion point) up, down, right, or left.
 Backspace Key -- Deletes the character just to the left of the
cursor (or insertion point) and moves the cursor to that position.
 Caps Lock Key -- A toggle key that, when activated, causes all
alphabetic characters to be uppercase.
 Delete Key -- Sometimes labeled Del, deletes the character at the
current cursor position, or the selected object, but does not move
the cursor.
 Enter Key -- Used to enter commands or to move the cursor to
the beginning of the next line. Sometimes labeled Return instead
of Enter.
 Esc Key -- Short for Escape, this key is used to send special
codes to devices and to exit (or escape) from programs and
tasks.
 Function Keys -- Special keys labeled F1 to Fx, x being the
number of function keys on the keyboard. These keys have
different meanings depending on which program is running.
 Return Key -- Another name for the Enter key.
Mouse
A device that controls the movement of the cursor or pointer on a display
screen. A mouse is a small object you can roll along a hard, flat surface.
Its name is derived from its shape, which looks a bit like a mouse, its
connecting wire that one can imagine to be the mouse's tail, and the fact
that one must make it scurry along a surface. As you move the mouse, the
pointer on the display screen moves in the same direction. Mice contain at
least one button and sometimes as many as three, which have different
functions depending on what program is running. Some newer mice also
include a scroll wheel for scrolling through long documents.

Computer Skills Checklist
 I know how to use a mouse and keyboard
 I know the difference between hardware & software
 I can launch or start a program
 I can close a program
 I know what a “drive” is
 I know what a window is
 I can use a scroll bar
 I can use a pull-down / drop-down menu
 I can open a file
 I can enter information into a document
 I can save a file or document
 I can underline, bold, and italicize text
 I can spell check a document
 I can use delete & backspace to make corrections
 I know when to use tab and the space bar
 I can insert text into an existing document
 I can change the font size and style of text
 I know what a browser is
 I can use the browser tool bar (back, home, etc.)
 I can type a web address in the address bar properly
 I can click on a web link
 I can identify at least 1 search tool
 I can enter information into a field or box
 I know the parts of an email address
 I know how to properly type an email address
 I know how to log in to and access an email account
 I know how to check for new messages
 I know how to compose a message
 I know how to reply to and forward an email message
 I know my email address
 I know the login name & password for my email account
 I know how to login to and access my email account
 I know how to check for new messages.

NOTES

Hardware and Software
Hardware refers to objects that you can actually touch, like disks, disk
drives, display screens, keyboards, printers, boards, and chips. In
contrast, software is untouchable. Software exists as ideas, concepts, and
symbols, but it has no substance.
Books provide a useful analogy. The pages and the ink are the hardware,
while the words, sentences, paragraphs, and the overall meaning are the
software. A computer without software is like a book full of blank pages -you need software to make the computer useful just as you need words to
make a book meaningful.
Software is often divided into two categories:
systems software : Includes the operating system and all the utilities that
enable the computer to function.
applications software : Includes programs that do real work for users. For
example, word processors, spreadsheets, and database management
systems fall under the category of applications software.
CPU
Abbreviation of central processing unit, and pronounced as separate
letters. The CPU is the brains of the computer. Sometimes referred to
simply as the processor or central processor, the CPU is where most
calculations take place. In terms of computing power, the CPU is the most
important element of a computer system.
Memory
Internal storage areas in the computer. The term memory identifies data
storage that comes in the form of chips, and the word storage is used for
memory that exists on tapes or disks. Every computer comes with a
certain amount of physical memory, usually referred to as main memory or
RAM. You can think of main memory as an array of boxes, each of which
can hold a single byte of information. A computer that has 1 megabyte of
memory, therefore, can hold about 1 million bytes (or characters) of
information.

Scroll bar

To check the spelling of your document:

A bar that appears on the side or bottom of a window to control which part
of a list or document is currently in the window 's frame. The scroll bar
makes it easy to move to any part of a file. Typically, a scroll bar has
arrows at either end, a gray or colored area in the middle, and a scroll box
(or elevator) that moves from one end to the other to reflect your position
in the document. Clicking on the arrows causes the document to scroll in
the indicated direction. You can also quickly move to any part of a
document by dragging the scroll box to the corresponding part of the scroll
bar. Many windowing systems support both horizontal and vertical scroll
bars.

1. Go to Review Tab
2. Go to Proofing Group
3. Choose Spelling and Grammar command. To choose this, take the pointer
and put it on the ABC button. (It should be gold). Left click one time to choose
spelling and grammar. If you have a misspelling, it will show you the misspelled
word and give you suggestions to either change it or ignore it. It will
automatically change the misspelled word for you.
To save your document:

Pull-down menu
A menu of commands or options that appears when you select an item
with a mouse. The item you select is generally at the top of the display
screen, and the menu appears just below it, as if you had pulled it down.
Internet
A global network connecting millions of computers. As of 2009, the Internet has
more than 1 billion users worldwide, and that number is growing rapidly.
Hundreds of countries are linked into exchanges of data, news and opinions.
Word processing
Using a computer to create, edit, and print documents. Of all computer
applications, word processing is the most common. The great advantage of word
processing over using a typewriter is that you can make changes without
retyping the entire document. If you make a typing mistake, you simply back up
the cursor and correct your mistake. If you want to delete a paragraph, you
simply remove it, without leaving a trace. It is equally easy to insert a word,
sentence, or paragraph in the middle of a document. Word processors also make
it easy to move sections of text from one place to another within a document, or
between documents. When you have made all the changes you want, you can
send the file to a printer to get a hardcopy.

1. Go to the File tab (shown in picture). Left click on the button. This will bring a
list of commands that you can use. If this is a new document, you will want to
select "Save As". Then you want to choose how you want to save it. If you have
Microsoft Office 2010 at home, you want to choose Word document, which is the
default setting. If you are saving your document, but you have an older version
of Microsoft Word at home, you will want to select the version of Word that you
have on your home computer. This will make your document compatible with
older versions of Word. This will bring up a screen that will say Save As. Then
you will need to tell the computer where you would like to save your document.
You do this at the Save in box at the top. We are going to save it in the USB
drive or J drive. This tells the computer that you want to save it on your flash
drive.

Please note: Some terminology and definitions are from Internet.com’s
Webopedia, an excellent source for computer questions:
(http://www.webopedia.com/)

Click

Basic Computer Applications: Getting to Know Word 2010

To tap on a mouse button, pressing it down and then immediately
releasing it. Note that clicking a mouse button is different from pressing (or
dragging) a mouse button, which implies that you hold the button down
without releasing it. The phrase to click on means to select (a screen
object) by moving the mouse pointer to the object's position and clicking a
mouse button. Some operations require a double click, meaning that you
must click a mouse button twice in rapid succession.

Microsoft Word is a word processing software program. If you have used Word
before, you may notice that it has a different look earlier versions; however, the
commands and functions are the same.
The Bar at the top is called the Ribbon. This has replaced the menus and
toolbars that you may have previously seen before.

CD-ROM / DVD / BluRay
Pronounced see-dee-rom, abbreviation of Compact Disc-Read-Only
Memory – a CD is type of optical disk capable of storing large amounts of
data. A DVD is a digital Video Disc, and is for video and sound files. A
bluray is a high-definition (sharper, clearer display) disc for video and
sound.
Desktop
In graphical user interfaces, a desktop is the metaphor used to portray file
systems. Such a desktop consists of pictures, called icons that show
cabinets, files, folders, and various types of documents (that is, letters,
reports, pictures). You can arrange the icons on the electronic desktop
just as you can arrange real objects on a real desktop -- moving them
around, putting one on top of another, reshuffling them, and throwing them
away.
Program
An organized list of instructions that, when executed, causes the computer
to behave in a predetermined manner. Without programs, computers are
useless. A program is like a recipe. It contains a list of ingredients (called
variables) and a list of directions (called statements) that tell the computer
what to do with the variables. The variables can represent numeric data,
text, or graphical images.

Tabs are designed to be task-oriented.
Groups within each tab break a task into subtasks.
Command buttons in each group carry out a command or display a menu of
commands
To Change the Font Size:
1. Go to Home Tab
2. Go to Font Group
3. Go to the command that has the number in it
4. Change the number with the command: the higher the number the bigger the
font. Do this by putting the pointer on the drop-down arrow to the right of the
number. Move the pointer downwards to choose a different font size. Left click
one time to change.

To Change the Font Style:

Hard disk (hard drive)

1. Go to Home Tab
2. Go to Font Group
3. Go to command that says Calibri (Body)
4. Change the font style by putting the pointer on the drop-down arrow to the
right of the the command. Choose a different style font. You can do this by
putting the pointer on the drop-down arrow to the right of the command. Move
the pointer downwards to choose a different font style. Left click one time to
change.

A storage place inside the computer, usually designated by the letter C.
The term “hard” means that it is hard-wired into the machine and is not
typically removable. Hard disks hold various amounts of information,
depending on the age (and price!) of the computer. Most home computers
hold between 500MB and 5TB of information.

To make the Text Bold:

Portable storage devices used to transport files from one computer to
another, and to keep backup copies of files.

1. Highlight a word or phrase in the practice invitation you typed. There should
be a blue box over the text that you highlighted.
2. Next, go to the Home Tab
3. Go to the Font Group
4. There is a capital letter "B" underneath the box that allows you to change the
font style.
5. Take the pointer and choose "B" (the "B" will have a gold color in it to indicate
that that is the command you are choosing). Left click on "B" one time. It will
stay this gold color until you are done bolding your text. To turn off the bold, put
the pointer on the "B" and left click one time. (The "B" should change back to
blue). The "I" and "U" next to the "B" mean italic and underline. Follow the same
steps for "B" only choose either "I" or "U" when appropriate.
To Center Text:
1. Highlight a line in the text that you typed. There should be a blue box over the
text that you highlighted.
2. Next, go to the Home Tab
3. Go to the Paragraph Group
4. Choose center. To choose center, take the pointer and choose the lines that
look centered. The line box will look gold. Left click one time. You should see
that you text that you highlighted has moved to the center of your paper.

Removable Storage Devices

3.5-inch Floppy Disk: Also called floppies or diskettes. Most can store up
to 1.44 MB of information. Floppies usually go into the A drive (or floppy
drive), but most new computers no longer include a floppy drive.
Compact Disc (CD) / Blu Ray / DVD: CD’s look like the CD’s that you use
to play music. To store files on a CD-R (a CD that allows you to store files
once, but then cannot be erased or overwritten) or a CD-RW (a CD that is
rewritable, or can be used multiple times), you need a CD burner and
appropriate software. A CD can hold far more data than a floppy disk.
Many computers now have a combined CD/DVD/Blu Ray drive, which
allows users to save (or “Burn”) data to a disk.
Flash Drive or Jump Drive: Also called pen drives, key drives, thumb
drives, or USB drives. These small devices can be attached to a keychain
and used in any computer with a USB port. A typical flash drive can hold
1G to 50GB of data, though some new flash drives can hold over 1TB
(terabyte) of information.
Icon
A small picture that represents an object or program. Icons are very useful
in applications that use windows, because with the click of a mouse button
you can shrink an entire window into a small icon. (This is sometimes
called minimizing.) To redisplay the window, you merely move the pointer
to the icon and click (or double click) a mouse button. (This is sometimes
called restoring or maximizing).

